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OBJECTIVES 
 
 
To enable students to evaluate the power of the OrCAD PCB tools used in the Windows-
based PCB design process. This manual can be used to perform all the steps in the PCB 
design process. The manual focuses on the sequence of steps to be performed in the PCB 
design cycle for an electronic design, starting with capturing the electronic circuit, 
through the PCB layout stages, and finishing with the processing of the manufacturing 
output and maintaining the design through ECO cycles. 
 
Tasks covered in this manual may not cover all the features of a tool. In this manual, the 
emphasis is on the steps that you will need to perform in each OrCAD tool so that your 
design works smoothly through the flow. 
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Electronic Engineering Drawing & Workshop Lab Session 01 

NED University of Engineering and Technology- Department of Electronic Engineering 
 

Lab Session 01 
 
OBJECTIVES 
 
Introduction to Orcad Capture: 
Generation of Schematic 
Generation of netlist 
 
TERMINOLOGY: 
 
OrCAD Capture 
OrCAD’s schematic design 
tool 
 
SCHEMATIC: 
A schematic is merely a collection of electronic symbols connected together with 
virtual “wires.” The main reason you need a schematic when fabricating a printed 
circuit board is to provide input (a netlist) to your layout and routing tool 
 
NETLIST: 
A netlist is a file, usually ASCII text, which defines the connections between the 
components in your design. 
 
CREATING PROJECT: 
 
To create a new project, use Capture’s Project Wizard. 
The Project Wizard provides you with the framework for 
creating any kind of project. 
 
1 Launch Capture. 
2 From the File menu, choose New > Project. 
3 In the New Project dialog box, specify the project name 
4 To specify the project type, select Analog or Mixed A/D. 
 
Note:. It also ensures that your design flows smoothly into OrCAD Layout for your 
board design. 
 
5 Specify the location where you want the project files to be created and click OK. 
6 In the Create PSpice Project dialog box, select the 
Create a blank project option button. 
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Adding parts: 
 
To add parts to your design: 
 
1 From the Place menu in Capture, select Part. 
2 In the Place Part dialog box, first select the library from which the part is to be added 
and then instantiate the part on the schematic page 
While working with the  Capture, add parts from “Name of Libraray”.OLB. 
To add libraries to the project, select the Add Library 
button. 
3 Browse to <install_dir>/tools/capture/library/pspice/eval.olb. 
 
Connecting parts: 
 
After placing the required parts on the schematic page, you need to connect the parts. 
From the Place menu, choose Wire. 
 
 
Net List: 
 
Save the schematic and close the schematic page. 
Open tools and create net list. 
Select Layout tab. 
Be sure to put the *.MNL file in a unique folder.  
Latter many more design  files will be generated and it will be much easier to sort them 
out if the design is by itself. 
Click on OK 
The net list that Layout needs has been created.  The file has the name of the project 
.MNL 
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Electronic Engineering Drawing & Workshop Lab Session 02 

NED University of Engineering and Technology- Department of Electronic Engineering 
 

Lab Session 02 
 
OBJECTIVES 
 
Introduction to Layout Tool, and creating Layout board 
 
TERMINOLOGY: 
 
OrCAD Layout 
OrCAD tool used for PCB routing and floor-planning 
 
LAYOUT: 
 
Layout is a circuit board layout tool that accepts a layout-compatible circuit netlist (ex. 
from Capture CIS) and generates an output layout files that suitable for PCB fabrication 
 
CREATING LAYOUT BOARD: 
 
Having created the layout netlist, the next step is to create a new board in Layout. 
 
Launch Layout 
Create the Layout board file 
 
When you create a new board file in OrCAD Layout, you merge the electrical 
information from the layout netlist (.MNL) and physical information from a template file 
(.TPL) or a technology file (.TCH) to create a new board design (.MAX). Therefore, to be 
able to create a board file for a new design in Layout, you need to provide a template file 
and a netlist. A template (.TPL) file describes the characteristics of a physical board. A 
template can include information, such as the board outline, the design origin, the layer 
definitions, grid settings, spacing rules, and default track widths. 
 
1 From the File menu in OrCAD Layout, choose New. The AutoECO dialog box appears. 
2 In the Input Layout TCH or TPL or MAX file text box, specify the name and the 
location of the technology file to be used for your board 
3 In the Input MNL netlist file text box, specify the location of the FULLADD.MNL 
created in the Creating Layout netlist section. 
Note that the Output Layout MAX file text box, is automatically populated with the name 
and the location of the Layout board file, FULLADD.MAX. 
Note: A Layout board file (.MAX) contains complete physical and electrical information 
about the board. 
4 From the drop-down list in the Options section, select AutoECO. 
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5 To create the Layout board file with the settings specified by you, click ApplyECO. 
The Layout progress box appears indicating that the board file is being created. The 
process of creating a board file will be completed only if the footprint information is 
available for all the components in the design. 
6 Once the AutoECO process is complete, the AutoECO dialog box appears with the 
report. To accept the changes, click the Accept this ECO button. 
7 The AutoECO message box appears stating that the process is complete. Click OK. 
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Electronic Engineering Drawing & Workshop Lab Session 03 

NED University of Engineering and Technology- Department of Electronic Engineering 
 

Lab Session 03 
 
OBJECTIVES 
 
Introduction to component footprints 
Editing & Creating new footprints 
 
EDITING FOOTPRINTS: 
 
Start the Layout software and choose 
File New. Next it will ask you which template file you would like to use. Click on 
Cancel. 
This will let you begin with a blank board. Choose File Library Manager. When you 
create a new footprint, you have two basic options, either you start with nothing, or you 
edit an existing footprint.  
To edit an existing footprint, select that footprint from the list on the left side of the 
screen. The footprint will appear in the work area to the right. After you have completed 
your edits then select the “Save As… ” button to save the edited footprint with a new 
name in your custom library. 
 
CREATING FOOTPRINTS: 

 In the Library Manager, click Create New Footprint. This will bring up the following 
dialog box. Name the footprint TO-220 REGULATOR IC, and keep English for the 
Units. Click OK to create the part. You will now see a new part with just one pin and lots 
of text in the Library Manager.  

If you like to switch to Metric units from English, then select Options System Settings 
to bring up the following dialog. Change the systems settings as shown. But I recommend 
that you work in English system of units because most PCB fabrication measurements are 
still done in inches or mils.  

Always remember the following conversions.  

1 inch = 2.54 cm  
1 inch = 1000 mils 
1 mm = 39.37 mils 
Use 1 mm = 40 mils for quick estimates.   

Click Cancel because you will be working in English units.  
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The IC has 3 pins, but we only need to define one padstack since the pins are all the same 
physically (not electrically). Open the padstacks spreadsheet. We will edit the padstack 
T1, which is already being used by pin1. First, let’s start from scratch and fill in 
information for only the layers that we care about. In the spreadsheet, double-click the 
padstack name T1. This brings up the Edit Padstack dialog for all layers in the padstack. 

First, change the name of the padstack to something like PSU_HOLE. Next, select the 
Undefined radio button. This will reset the padstack definitions on every layer. Click OK 
to continue. In the spreadsheet you should now see a padstack called 
REGULATOR_PIN with no layers defined.   

We will now set each layer individually. You can also select multiple layers at a time by 
holding down the CTRL key when you click the layer name. First, let’s define the size of 
the drill used for this part. The datasheet tells us that the pin dia can vary from 0.027 to 
0.037 in. So we should use a drill of dia greater than 37 mils. Let us use a drill of 40 mils. 
Select the layers DRLDWG and DRILL. When you have multiple layers selected, you 
will need to right-click and choose Properties or press CTRL+E to bring up the Edit 
Padstack dialog. Choose the Round radio button and give the width and height a value 
of 40. Click OK when done. The changes you made should now be reflected in the 
spreadsheet.   

Now we will define the amount of metal on the routing layers beyond the size of the drill. 
This is called the annular ring. Each board shop will have requirements on the minimum 
annular ring size based on the drill diameter. In most cases 20 mils is a safe bet. Select 
the TOP, BOTTOM layers and bring up the Edit Padstack dialog. Make the pads round 
and put the value of 60 (40+20 mils) in the height and width fields.   

The last thing we need to define is the solder mask. This is usually defined as slightly 
larger (about 5 mils) that then annular rings on the top and bottom layers. Select SMTOP 
and SMBOT and make them round pads with height and width of 65 (60+5 mils).   

You have finished defining your padstack for this part. Your Padstacks spreadsheet 
should now look this.   
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You can close the spreadsheet and you will see that pin 1 should now look a little 
different based on the changes you just made. You probably noticed that you don’t need 
to define all of the layers. As a guide, here are the layers that you need to define for thru-
hole technology (THT) and surface mount technology (SMT) parts.   

• THT components: TOP, BOTTOM, SMTOP, SMBOT, DRLDWG, 
DRILL  

• SMT components:  TOP, SMTOP, SPTOP  

As far as padstacks are concerned, surface mount parts are a lot easier to work with. But 
we will rarely work with SMT parts because they require special equipments for 
soldering. 

Now click Save. Since you are saving this footprint for the first time, you will be asked to 
select the library to keep the footprint in. You have not yet created a footprint library, so 
you will need to click the Create New Library button. Browse to your libraries 
directory and name the library PSU_FOOTPRINTS.   
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Let’s now clean up a few things before 
adding the rest of the pins. You will see 
a lot of text on your screen. Most of it is 
on the layer ASSYTOP, which we will 
not use. This text is safe to delete. Open 
the text spreadsheet and you will see five 
text items. Select all the text on the 
ASSYTOP layer and delete them. This 
will clean up your footprint a bit. You 
can leave the reference designator text 
on the SSTOP layer. We will need it.   

Before creating all the pins for a part, 
please make note of a few things. The name of the pad is very crucial. It MUST MATCH 
the number property of the corresponding pin in the schematic symbol. To know what 
are the pin numbers, open your schematic in Capture and double click U1 i.e. LM317. 
Click the Pins tab and select Orcad-Capture in the drop-down box. Now look at the 
Number property. It should look like the figure below. Hence the pin numbers for your 
IC are 1, 2 and 3. Most of the time, the pins are numbered as 1,2,3,4… but this is not 
always the case.   

   

Refer to the datasheet again. The spacing between adjacent pins is given to be 90 – 110 
mils. We will use the mean spacing i.e. 100 mils.  We can add pins to the footprint in a 
number of ways, but the easiest way to do this is to use the footprints spreadsheet. Open 
the spreadsheet and you will see just pin 1 with an (x,y) location of (0,0). Always place 
pin 1 at (0,0). To create a new pin, just highlight pin 1 in the spreadsheet and type 
CTRL+C. This will open up the following Add Pad dialog.   

 Type 2 in the Pad name because the next pin number in schematic symbol is 2. Type 
100 as the x-coordinate to place the next pad 100 mils apart from origin i.e. pad 1. 
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Choose the PSU_HOLE padstack for the pin. In most cases, you will leave the other 
settings as they are by default. Add the third pad in the similar manner.  

The spreadsheet should now look like this.   
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Electronic Engineering Drawing & Workshop Lab Session 04 
NED University of Engineering and Technology- Department of Electronic Engineering 

 
Lab Session 04 

 
OBJECTIVES 
 
Overview of Autorouting using Orcad Layout 
 
Autorouting using Layout: 
 
OrCAD Layout supports autorouting of board, components, and DRC. Board autorouting 
implies that the nets on the complete board are routed. Component routing routes only the 
nets attached to the selected component. DRC routings implies that all the nets within the 
DRC box defined by the user are routed. 
 
To autoroute a component: 
 
1 From the Auto menu, choose Autoroute > Component. 
2 Select the component that you want to route. All the nets connected to that component 
are routed.  
Similarly, to automatically route a complete board, choose Board from the Autoroute 
submenu. To autoroute region choose DRC from the Autoroute submenu 
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Electronic Engineering Drawing & Workshop Lab Session 05 
NED University of Engineering and Technology- Department of Electronic Engineering 

 
Lab Session 05 

 
OBJECTIVES 
 
Overview of Manual using Orcad Layout 
 
PROCEDURE: 
 
The steps in the manual routing process are: 
 

• Check the board outline, via definitions, and routing and via grids 
• Load a routing strategy file 
• Route power and ground 
• Fan out SMDs and verify connections to power and ground 
• Route the remaining signals using the manual routing tools 
• Optimize routing using the manual routing commands 
• Check for route spacing violations and check routing statistics 

 
 
To manually route nets with planes and copper pours 
 
1 From the Options menu, choose User Preferences. The User Preferences dialog box 
appears. 
2 Select the Enable Copper Pour option, select the Use Pours for Connectivity option, 
then choose the OK button. 
3 Choose the refresh all toolbar button to update the connectivity database. Ratsnests will 
disappear from connections that have been completed through planes 
and copper pour. 
4 Display the User Preferences dialog box again and deselect the Enable Copper Pour 
option, but leave the Use Pours for Connectivity option selected. This ensures that copper 
pour won’t obscure items you may want to work with, but still allows the Use Pours for 
Connectivity option to function. 
5 Choose the spreadsheet toolbar button, then choose Nets. The Nets spreadsheet appears. 
6 Select all the nets, then choose Properties from the pop-up menu. The Edit Net dialog 
box appears. 
7 Choose the Net Reconn button. The Reconnection Type dialog box appears. 
8 Select the No Dyn. Reconn option, then choose the OK twice to close the dialog boxes. 
information, see Previewing thermal 
You can also view the thermal connections using the post process preview. For more 
9 Manually route the nets. You can use T-routing, even though dynamic reconnect is 
disabled. 
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Using manual routing tools: 
 

• You can use add/edit route mode to create new tracks from a ratsnest. To edit 
existing tracks without unrouting them, place your cursor on any routed vertex or 
segment 

• and click the left mouse button. You can use edit segment mode to move existing 
• segments of tracks, create new segments, or remove segments. When a horizontal 

segment is moved up or down, the connecting segments lengthen or shorten in 
• order to accommodate the changes to the selected segment. The selected segment 

and its connecting segments change size as necessary. 
 

• When using the manual route tools, the following options are available in the 
Route Settings dialog box (from the Options menu, choose Route Settings). The 
Use All Via Types option allows Layout to use the optimal via type from among 
all the vias defined in the Padstacks spreadsheet. If this option is not selected, and 
you have not specified a via for use with a given net, then Layout uses Via 1 (the 
default via type). 

 
• With the Snap to Grid Routing option selected, the segment that you are routing 

moves from grid point to grid point, so that you cannot create a track off of the 
routing grid. When you deselect this option, you are able to route regardless of the 
track’s relationship to the routing grid. 

 
• The Any Angle Corner option allows you to create an angle of any kind. When 

you select this option, the connection segment attached to the routing tool’s 
crosshairs rotates freely through 360°. 

 
• The 135 Corners option allows you to create angles of 90° or 135° while you 

route. 
 

• The 90 Corners option restricts angles to 90°. 
 

• The Curve Corners option gives you the ability to place curved tracks on your 
board while you route manually. With a routing tool selected, you can create 
curved, horizontal and vertical tracks (however, you cannot readily create 135° 
angles with this option 

• selected). 
 

Using add/edit route mode: 
 
You can use the add/edit route mode to route new tracks and edit existing tracks. If you 
select a partially routed track, you can continue routing the track, one segment at 
a time, at a 135° or 90° angle. When you select a track at a where there is copper on more 
than one layer, the router edits the track that is on the current layer. 
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If you pick up an existing track, press the s, and type a layer number, the track switches 
to the new layer, and vias are installed automatically where necessary. If it is impossible 
to clear room for the vias, the router responds with beeps and does not switch the track.  
 
To manually route a track: 
 
1 Choose the add/edit route toolbar button. 
2 Choose the zoom in toolbar button, then click the left mouse button to magnify the area 
to route. Press E to exit zoom mode. 
3 Select a ratsnest with the left mouse button. The ratsnest attaches to the pointer. 
4 Drag the pointer to draw a track on the board. 
5 Click the left mouse button or press the s to create vertices (corners) in the track. 
6 When drawing the last segment for the connection, choose Finish from the pop-up 
menu. The track automatically connects to the center of the pad. A complete connection 
is indicated by the cursor changing size and the ratsnest disappearing from the pointer. 
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Electronic Engineering Drawing & Workshop Lab Session 06 
NED University of Engineering and Technology- Department of Electronic Engineering 

 
Lab Session 06 

 
OBJECTIVES 
 
Overview of Auto Routing using Orcad Specctra 
 
When you select the SPECCTRA autorouter, the complete board is routed. Unlike 
Layout, which uses grid-based routing, SPECCTRA uses shape-based routing and is a 
faster routing tool. 
To use the SPECCTRA auto router, 
 
1 From the Auto menu in Layout, choose Autoroute and then select SPECCTRA. 
 

 
 
2 In the SPECCTRA interface dialog box, specify the location of the SPECCTRA exe to 
be used. 
In the demo CD, SPECCTRA is located  <install_dir>/OrCAD/OrCAD_10.0_Demo/tool 
s/specctra/bin. 
3 Specify the name and location of the .DO file to be used for running SPECCTRA. 
To create a DO file for the full adder design, click Create. 
4 In the message box that appears, click NO. 
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5 The name and the location of the DO file created by OrCAD Layout appears in the text 
box. By default, a file named SpecctraWithinLayout.do is generated. 
6 To start Autorouting, click Route. A message box appears stating that SPECCTRA 
licenses are not available and the demo version of the tool will be launched. 
7 Click OK to start the demo version of SPECCTRA. 
8 The autorouting process starts and the board is routed as shown in the figure below: 
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Electronic Engineering Drawing & Workshop Lab Session 07 
NED University of Engineering and Technology- Department of Electronic Engineering 

 
Lab Session 07 

 
OBJECTIVES 
 
Introduction to Post Processing 
 
POST PROCESSING: 
 
This section introduces some of the tasks that are not a part of the placement and routing 
process, but are related and can be performed using OrCAD Layout. 
 
Renaming components: 
 
After you have completed the placement and routing of your PCB board, you can rename 
the components on the PCB board in a specific order. 
 
1 From the Options menu, choose Components Renaming. The Rename Direction dialog 
box appears. 
2 Select one of the renaming strategies.For the full adder design, select Right, Down. 
3 Click OK. 
4 From the Auto menu, choose Rename Components.Layout renames the components. 
The reference designators for the component on the board changes. 
 
Back annotation: 
 
While creating a PCB board, you might make some changes in the layout board (.MAX) 
file. As a result, the board file and the design file in Capture may be out of sync. To 
ensure that both these file are in sync, you can backannotate the changes in the PCB 
board file to the Capture. 
When you backannotate, information, such as component location and component names 
(changed due to renaming) gets added on to the schematic in Capture. 
To generate the backannotation file: 
 
1 From the Auto menu in Layout, choose Back Annotate. 
2 A message box indicating the location of FULLADD.SWP file appears. Click OK. 
The .SWP file generated by Layout after backannotation is read by OrCAD Capture. 
 
To backannotate the changes to the schematic: 
1 Open FullAdd.opj in Capture. 
2 In the Project Manager window, select fulladd.dsn. 
3 From the Tools menu in Capture, select Back Annotate. 
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4 In the Backannotate dialog box, select the Process entire design option button. 
5 Select the Update Occurrences option button. 
6 Specify the location of the .SWP created by Layout. 
7 Click OK. 
 
The schematic is updated with the changes in the board file. Similarly, if the board file is 
open in Layout and you make changes in the schematic design, you can ensure that these 
changes are forwarded to the board during Layout netlist creation. 
To do this: 
 
1 In the Project Manager window, select thefulladd.dsn. 
2 From the Tools menu, choose Create Netlist. 
3 In the Layout tab of the Create Netlist dialog box, select the Run ECO to Layout check 
box. 
4 Click OK. The changes in the schematic design will appear in the board 
file. 
 
Generating output: 
 
The final task in creating a board design is to generate output files. You can create Gerber 
files, drill files, DXF files, and printer/plotter files. 
Before you generate reports and output files, you should clean up the design. To clean up 
your design: 
 
1 From the Auto menu, choose Cleanup Design. The Cleanup Design dialog box appears. 
2 In the Cleanup Routing section, click the Select All button. 
3 In the Cleanup Database section, select all three check boxes, to ensure that unused 
padstacks, footprints, and Nets are removed. 
4 Click OK. Message boxes appear indicating the cleanup process being 
performed. You can now generate the desired output files and reports. 
 
Output files: 
 
Using OrCAD Layout, you can generate various files that can further be used with 
various third-party tools, such as GerbTool, IntelliCAD, VisualCAD, AutoCAD, and so 
on. 
To generate these output files, complete the following steps: 
 
1 From the Options menu, choose Post Process Settings. 
The Post Process spreadsheet appears. 
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2 Select the Device column. 
3 Right-click and select Properties from the pop-up menu. The Post Process Settings 
dialog box appears. 
4 Select the required options. 

• To create files to be used with Gerber tools, select Gerber RS-2740 or extended 
Gerber. 

• To create files with mechanical information that is to be used with the CAD tools, 
select DXF. 

• To create HPGL files select Print Manager. To create HPGL file, you must have 
the HPGLprinter installed. 

• In the Post Process Settings dialog box, select theExtended Gerber check box. 
5 Select the Create Drill Files, Overwrite Existing Files, and Enable for Post Processing 
option buttons. 
6 Click OK. 
 
Gerber files are generated. 
7 Close the Post Process spreadsheet. You can also generate output files using the Run 
Post Processor command. 
 

i. From the Auto menu, choose Run Post Processor. 
ii. A message box appears indicating the generated filename. Click OK. 

 
After Layout creates the post processing files, a post 
processing log file displays. 
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Electronic Engineering Drawing & Workshop Lab Session 08 
NED University of Engineering and Technology- Department of Electronic Engineering 

 
Lab Session 08 

 
OBJECTIVES 
 
Introduction to Gerbtool 
 
GERB TOOL: 
 
GerbTool provides a powerful set of Windows-based CAM tools, including a feature-rich 
and robust Gerber/NC editor for ensuring a seamless link between PCB design and 
manufacturing. GerbTool is designed to provide CAD/CAM professionals with the tools 
they need for complete control over their CAM databases. 
From visual verification to high-level CAM tools, GerbTool simplifies and automates 
your PCB layout post processing and pre-manufacturing tasks. GerbTool’s consistent and 
intuitive graphical user interface, and programmable mouse buttons and function keys, 
allow you to focus on accomplishing tasks, rather than on the technical details of 
operating the software. 
 
 
GerbTool features: 
 

• Fast and easy to use. 
• Unlimited file sizes. 
• Accurate to 1/100 mil (.00001 in.). 
• Fully automatic panelization and venting. 
• Complete undo to beginning of session. 
• Full design rule checking (DRC), including annular ring checking and stub 

detection. Snoman™ pad/trace filleting. 
• Teardrop pads. 
• NC drill optimizing, including step and repeat. 
• Isolated pad removal. 
• Automatic removal of silkscreen data from pads. 
• Full support for true multilayer netlists, including net highlighting. 
• Scalable check plots to HPGL, PostScript®, Laser printers, and all 

printers/plotters supported by Windows. 
• Conversion of drawn pads to flashes. 
• Macro language allows the addition of new commands. 
• Metric and Imperial formats supported. 
• Photoplotter support includes extended Gerber, FIRE9xxx, EIE, BARCO DPF 

and IPC-D-350. 
• Accurate display of power and ground plane composites. 
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• Allows aperture scaling to create soldermasks, shrink/expand traces, and so on. 
• Ability to scale layers to shrink or expand the database. 
• Merge a complete design or a single Gerber file into another. 
• Import NC Drill, HPGL, or BARCO files. 
• View up to 999 layers simultaneously. 
• Handles over 4000 apertures in up to 999 aperture lists. 
• Aperture list conversion tools allow the addition of custom aperture list 

converters. 
• Easily created custom apertures and custom fonts. 
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Electronic Engineering Drawing & Workshop Lab Session 09 
NED University of Engineering and Technology- Department of Electronic Engineering 

 
Lab Session 09  

 
Introduction of the materials required for the fabrication of PCB’s.  
 
OBJECTIVES 
 
Upon the completion of this experiment, you will be able to:  

 1. Know about the equipment, materials, tools and machines that are used for the 
making of PCB.  

 2. Use these materials, equipment and tools for making of PCB.  

 
BACKGROUND: 
 
The designer as well as manufactures prefers to use both the imperial as well as non-
imperial system of units.  
The most important to remember are:  
1mil = inch by 1000  
1mil = 25.4 micron  
1micron = 1mm by 1000  
Tracks on a PCB add inductance, resistance and capacitance to the circuit.  
 
INDUCTANCE: 
  
The amount of inductance is relatively constant across substrate types and depends on 
the length of track. The inductance per unit length of copper track is similar to that for a 
component lead.  
I n H/m m.  
 
RESISTANCE: 
 
Resistance of the track depends on the cross-sectional area of the track as well as the 
length, hence values are usually quoted in resistance per square for each weight of 
copper the most popular copper weight,1 oz., gives a typical value of 0.49mΩ/square.  
 
CAPACITANCE:  
 
C=_

0
_

r
A/h 

 
Where as _

0=
8.854 pF/m  

 
=4.7for FR4  
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A=coverage area  
H=distance between tracks  
 
Therefore a 1 oz. copper track, .5mm (0.020 “) wide, 20 mm (.8“) long over a ground 
plane on a .25 mm (.010”) thick FR4 laminate would exhibit a resistance of 9.8mΩ, an 
inductance of 20nH,and a capacitive coupling to ground of 1.66 pF. These values may 
seem like low and negligible but when we talk of so many track then these values add 
up. These parasitic effects are under designers control very muck like components 
values.  
There are other design constraints like production, marketing cost etc.  
Some important tables are given here for the ready reference and handy, fast 
calculations.  
 
LAMINATE MATERIAL PROPERTIES: 
 

Base 
material  

Ref. 
Name  

Relative  
Dielectric  
Constant(Cr) 

Max. Temp.  
Tmax(degree 
Celsius)  

Thermal  
Conductivity  
K(W/m per 
K)  

Remarks 

Dysfunctional  
epoxy  

FR4  4.2 - 4.9  120 130  0.18  

 
COPPER TRACK PROPERTIES: 
 

Copper  
Weight(oz.)  

Track  
Thickness  
(mm)  

Track  
Thickness(inches)  

Track resistance(m  
ohms/square(1mm*1mm)  

 
OBSERVATION: 
 
Take a copper clad board. At first, single side copper board, Measure and note the 
following parameters in it.  
 

Base  
material  

Ref.  
Name  

Relative  
Dielectric  
Constant(Cr)  

Max. Temp.  
Tmax(degree  
Celsius)  

Thermal  
conductivity  
K(W/m per K)  

Remarks  

 
COPPER TRACK PROPERTIES: 
 

Copper  
Weight(oz.)  

Track  
Thickness  
(mm)  

Track  
Thickness(inches)  

Track resistance(m  
ohms/square(1 mm* 1 mm)  
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Show calculations also. Refer the background and other notes for the calculations.  
Calculate the came tables for the double-sided board also. Compare the results of single-
side and double-side boards. Note the difference.  
Then compare your results with the standards given in the tables.  
 
SUMMARY: 
 
The availability of the copper plate of the proper size is the first and foremost 
requirement for the making of the PCB.In addition to it, you also require the precision 
high speed cutter blade for the fine and précised cutting of these copper plates to the 
required size. There can be the manual drilling machine for the drilling of the holes for 
components to be placed or the automatic plant as to the availability of the resources at 
your hand. There is the list of other equipment to add this like a personal computer 
printer, saw, scale, photo plotter, screen printing facility, chemicals, chemical treatment 
plant for the exposing and lamination of the PCB.  
 
TESTS AND MEASUREMENTS: 
 
Measure the diameter of the copper plate by the verneir caliper. Use the scale for 
measuring the area of the copper plate to be processed. Test checks all the machines 
before making the start as all the machines are to be précised to your choice.  
 
PRELIMINARY INSTRUCTIONS: 
 
It is better to know about the each material, tools, machines and equipment etc.  
Use the copper plates of the proper choice not to wast the copper plates as they are costly 
equipment.  
Handle machines with the utmost care as they might be damaged as they are sensitive.  
You might also hurt yourself while working on these machines.  
 
EXPERIMENTAL PROCEDURES: 
 

 1. Make a list of all the items that are to be introduced to you.  

 2. Write brief introduction about the each item.  

 3. Subdivide it into material, equipment, tool, machine, etc.  

 4. Write about it’s usage as explained to you one by one.  

 5. Use each of the items as explained to you by the instructor.  
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Electronic Engineering Drawing & Workshop Lab Session 11 
NED University of Engineering and Technology- Department of Electronic Engineering 
 

Lab Session 11  
 
 
Practical on the identification of Drill Bits and Drilling on the manual drill Machine.  
 
OBJECTIVES:  
 
Upon the completion of the experiment, you will be able to:  
 

 1. Know about the sizes of the different drill bits for drilling holes in PCB.  
 2. Perform the drilling of holes of any suitable size on a PCB.  

 
BACKGROUND:  
 
The drill bits come in different sizes as the boards vary in the size too. The drill bit can be 
less than a fraction of mm to any No. of millimeters. The minimum size of the drill bit is 
related to the technology. It the technology is so précised than the drill bit size go on 
reducing to the limitations permitted by the resources at hand and the machiner4y 
involved. As the drill bit size is reduced and the automation is introduced so is the size 
increased. If some one wants perform the drilling on the CNC (COMPUTER 
PNEUMATIC CONTROL) machine, it is more précised, especially in the working of IC 
pads. As the sizes involved are mils only.  
So it also depends upon how you plan to go ahead. First of all, the person whole wants 
tool drill must do sketches on the copper board if he is performing the drilling manually. 
If he is do prcise4d at the handling of the machine than he can work without the 
sketching and can sue any other method foe getting the exact point where he has to drill a 
hole.  
Normally the manual machine has a motor attached to it that revolves around and there is 
a slot vacant for inserting the drill bit. 
 
CNC DRILLING:  
 
The techniques for drilling copper clad for double-sided and multilayer PCBs with 
automated equipment are identical, with the exception that multiple drilling steps will be 
needed if your multilayer design includes buried or blind vias. Refer to the 
documentation that came with your drilling machine for more information (standard 
boilerplate cop-out). Items to remember include:  
 

• Set the STACK HEIGHT parameter to clear all dowel pins during traverse  

• Set the SPINDLE FEED (inches per minute) and SPINDLE SPEED (RPM for 
each drill size to values consistent with drilling standard 0.062” (1.6mm) FR-4 
cooper clad.  
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• Set the SPINDLE PLUNGE DEPTH so that the tip of the largest diameter drill bit 
fully enters the backing material. Otherwise, these large diameter holes will not 
totally penetrate to bottom laminate and exit foil.  

• DO NOT contour route the board immediately after drilling the stack. This should 
only done after all other processing is complete.  

 

MANUAL DRILLING:  

• With the laminate stack formatted as detailed above, manual drilling is a 
straightforward, if somewhat mind-numbing process. Items to consider include.  

• When using a conventional drill press, hole placement accuracy can be improved 
and drill breakage minimized through the sue of a “sensitive drilling” or “finger” 
chuck. Small format, precision high speed drill precision, ideal for PCB 
fabrication, is also available from a number of sources.  

• Regardless of the type of drill press being used, a pressure foot should be 
employed if available.  

• If available, position a work lamp on a flexible mount as close to the work surface 
as possible.  

• Although more brittle than conventional high speed steel (HSS) drills, tungsten 
carbide bits designed specifically for PCB drilling will yield far superior hole wall 
quality. Minimize burr formation, and outlast HSS bits almost 10 to 1. The 
downside is t that, with smaller break and must be handled carefully.  

• Always use drill bits that have been fitted with depth setting rings. This will allow 
you to set the plunge depth stop on your drill press to a single value that will work 
for all bit 

• Diameters.  

• Prepare a chart that links the various diameter bits with the symbols used in the 
drill master. 

THROUGH-HOLES:  

 1- Load the larges diameter bit to be sued into the drill chuck, making sure that the 
depth ring is pressed firmly against the ends of the chuck jaws when they are fully 
tightened.  

 2- Using a piece of scrap backing material as a gauge, adjust the spindle travel stop 
on your drill press to a depth that insures that the entire tip of the drill bit penetrates 
at least half of the material’s thickness. You can also use tow pieces of entry foil as a 
feeler gauge” to set the depth. Under no circumstances allow a PCB drill bit to drill 
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into the table of your drill press. PCB bits are specifically designed to drill copper 
clad and will shatter if plunged into cast iron, steel, or aluminum.  

 3- Starting with largest diameter drill bit, drill all of the through holes, stopping 
periodically to insure that the drill bit have not snapped off and that the spindle travel 
stop has not slipped.  

 4- As you drill each hole size (from the largest to the smallest) check off that 
diameter on the drilling chart. This is a good bookkeeping technique that will help 
you keep track of your progress and insure that no hole size is missed.  

5- After all of the holes have been drilled, remove the backing material from the 
stack and re tape the remaining sheet with the dowel pins in places.  

 6- Hold the stack up to the light for visual inspection. Ascertain that all of the holes 
have been drilled through and that \none are blocked by drill debris. If some debris is 
seen, remove by carefully pushing a smaller diameter drill bit through the hole.  

 7- If all of the holes ;in your circuit design go all the way ;through the board, you are 
now ready to activate hole walls to prepare for through-hole plating.  

 

BLIND OR BURIED VIAS:  

Designs that sue blind or buried vias (vias that do not penetrate through the PCB) need 
supplementary drilling operations before proceeding. Unfortunately, they are also quite a 
bit more difficult to activate and through plate since each must be processed singly.  

1. Fully disassemble the drilled stack.  

2. Reassemble a sub stack consisting of the backing sheet, one of the copper clad 
substrates that need additional drilling, and the entry foil that carries the 
drillmaster.  

3. Re-pin with the dowels and tape as before.  

4. Playing close attention to the drill master symbols representing the holes needed 
by the included substrate, drill the sub stack.  

5. Disassemble the sub stack and repeat steps 2 through 4 for each layer that needs 
further drilling.  

6. Inspect each layer after it is drilled and remove any debris that might be blocking 
the holes.  

7. If all of the holes are drilled to your satisfaction, the individual layers are now 
ready for activation. 
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SUMMARY:  

 
• When using a conventional drill press, hole placement accuracy can be improved 

and drill breakage minimized through the sue of a “sensitive drilling” or “finger” 
chuck. Small format, precision high speed drill presses, ideal for PCB fabrication, 
is also available from a number of sources.  

 
• Regardless of the type of drill press being used, a pressure foot should be 

employed if available.  
 

• If available, position a work lamp on a flexible mount as close to the work surface 
as possible.  

 
• Although more brittle than conventional high speed steel (HSS) drill, tungsten 

carbide bits designed specifically fro PCB drilling will yield far superior hole wall 
quality, Minimize burr formation, and outlast HSS bits almost 10 to 1. The 
downside is that, with smaller diameters [0.018” (0.46mm) and less], the carbide 
drills are easier to break and must be handled carefully.  

 
• Always use drill bits that have been fitted with depth setting rings. This will allow 

you to set the plunge depth stop on your drill press to a single value that will work 
for all bit diameters.  

 
• Prepare a chart that links the various diameter bits with the symbols used in the 

drillmaster.  
 

 
 
TESTS AND MEASUREMENTS : 

 
MINIMUM DRILL HOLE SIZE, PCB THICKNESS: 
 
S. 
No.  

PCB 
THICKNESS MM  

PCB THICKNESS 
INCHES  

DRILL HOLE 
SIZE MM  

DRILL HOLE 
SIZE INCHES  

 
 
PRELIMINARY INSTRUCTIONS: 
 

1. Always wear safety classes when operating a drill press, especially if you are 
drilling with carbide PCB drill bits.  
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2. If available, always use a vacuum cleaner to remove debris and collect airborne 
dust during the drilling operation.  

 
 
3. The dust generated during PCB drilling can pose a very; serious health hazard and 

should not be inhaled or ingested under any circumstances.  
 
EXPERIMENTAL PROCEDURE:  
 
Through-holes: 
 

1. Load the larges diameter bit be used into the drill chuck, making sure that the 
depth ring is pressed firmly against the ends of the chuck jaws when they are fully 
tightened.  

2. Using a piece of scrap backing material as a gauge, adjust the spindle travel stop 
on your drill press to a depth that insures that the entire tip of the drill bit 
penetrates at least half of the material’s thickness. You can also sue two pieces of 
entry foil as a “feeler gauge” to set the depth. Under no circumstances allow a 
PCB drill bit to drill into the table of your drill press. PCB bits are specifically 
designed to drill copper clad and will shatter if plunged into cast iron, steel, or 
aluminum.  

3. Starting with the larges diameter drill bit, drill all of the through holes, stopping 
periodically to insure that the drill bit have not snapped off and that the spindle 
travel stop has not slipped.  

4. As you drill each hole size (from the largest to the smallest) check off that 
diameter on the drilling chart. This is a good bookkeeping technique that will help 
you keep track of your progress and insure that no hole size is missed.  

5. After all of the holes have been drilled, remove the backing material from the 
stack and re tape the remaining sheets with the dowel pins in place.  

6. Hold the stack up to the light for visual inspection. Ascertain that all of the holes 
have been drilled through and that none are blocked by drill debris. If some debris 
is seen, remove by carefully pushing a smaller.  

7. If all of the holes in your circuit design go all the way through the board, you are 
now ready to activate the hole wall to prepare for through-hole plating.  

 
BLIND OR BURIED VIAS:  
 

8. Designs that sue blind or buried vias (vias that do not penetrate through the PCB) 
need supplementary drilling operations before proceeding. Unfortunately, they are 
also quite a bit more difficult to activate and through plate since each must be 
processed singly.  

9. Fully disassemble the drilled stack.  
10. Reassemble a sub stack consisting of the backing sheet, one of the copper clad 

substrates that need additional drilling, and the entry foil that carries the 
drillmaster.  

11. Re-pin with the wholes and tape as before  
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12. Playing close attention to the drillmaster symbols representing the holes needed 
by the included substrate, drill the sub stack.  

13. Disassemble the sub stack and repeat steps 2 through 4 fro each layer that needs 
further drilling.  

14. Inspect each layer after it is drilled and remove any debris that might be blocking 
the holes.  

15. If all of the holes are drilled to your satisfaction, the individual layers are now 
ready for activation.  
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Electronic Engineering Drawing & Workshop Lab Session 11 
NED University of Engineering and Technology- Department of Electronic Engineering 

 

Lab Session 11 
 

 
To understand the electroplating processes on ABC plating line in 
COMPACTA machine BUNGARD.  
 
OBJECTIVE:  
 
To learn the principles and methods involved in electroplating.  
 
BACKGROUND:  
 
There is a sequence of Baths involved in plating system:  
The total No. of bathes is six (6).  
Bath = 1: This Bath is for cleaning and conditioning  
Bath = 2: This bath is for Pre-Dip. We must use the pre-Dip solution for cleaning tank 3.  
Bath = 3: Catalyst: To stir the bath, always use a very clean glass or plastic rod.  
Bath = 4: Intensifier.  
Bath = 5: Spare bath. 
 
This spare bath can be used for electro less tin plating at the room temperature. If not in 
use, please fill this tank with water.  
Bath = 6: Copper plating: Fix both anode holders, use anode bags to cover anodes and 
use the strings to form a knot so that the bags are kept in place.  
For proper copper plating results, it is necessary to run the anodes under working 
conditioned but with reduced current of 1 A/dm .sq.  
The COMPACTA ABC unit is equipped with triple cascade rinse section. Pre rinse 
always in the bath with the highest water level followed by the one with the lower level.  
 
SUMMARY:  
 
We must connect the proper supply to the plating unit. The cable should be placed in a 
proper way, Remove the plug if you are not using the machine. Take special care that the 
liquid must not pass the housings, set up the appliance in a proper room. Close the drain 
valves before filling the tanks. The temperature of the solution can differ from the actual 
temperature  
Wear goggles and protective glasses for work. In the system, the conveyer arms are 
removable and adjustable. Here is a front rinsing system for the rinsing of PCB at 
different stages. There are five treatment tanks in the system. They can be divided into  

 1. Treatment tanks  
 2. Electroplating tanks  
 3. Control section  
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TESTS & MEASUREMENTS:  
 

1. The treatment Dimensions:  
 

Internal Dimensions:  
300*100*400 mm (D*W*H)  
Content: approx. 10 Liters  
Two tanks are equipped with PTFE coated heating elements: 220 V, 400Watt  
The first tank can be heated upto: 70 Degree Celsius 
 
The first tank can be used upto: 50 Degree Celsius  

2. Electroplating Tank:  
 

Internal Dimensions:  
400*275*400 (D*W*H)  
Capacity: Approx 30 Liters.  
 

3. Control Section:  
 
Two thermostats with a switch, one air pump 400I/h with switch, main switch. 5 
electronics timers. Conveyor potentiometer with switch, rectifier adjustable up to 6V, 
40A. And switch, internal fuses.  
The cleaning unit is made of PVC.  
 
PRELIMINARY INSTRUCTIONS:  
Safety Instructions:  

 • Do not uses for any other application than through hole plating.  
 • Read all safety instructions. Take extra care that there is no extra humid or wet. 

Environment.  
 • To avoid electric shock do not remove the housing.  
 • Keep the safety and operating instructions somewhere safe in use.  
 • In your interest, pay attention to all safety warnings.  
 • Whenever you use the unit ensure that there is the sufficient ventilation in the 

room.  
 
EXPERIMENTAL PROCEDURES:  
 

 • Cut the PCB to size with board cutter .The blank size must be 20mm larger.  
 • Drill your PCB board to required hole pattern. Allow 0.05 to 0.01 mm extra dia 

for the drill bits.  
 • Fix the cleaned board in the MACHINE. Fix it in the three-finger board holder. 

Start from bath 1 (Left side)  
 • Process the board as per instructions from bath 1 to 6 with the sequence and 

timings as per the instructions in the machine manual.  
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Electronic Engineering Drawing & Workshop Lab Session 12 
NED University of Engineering and Technology- Department of Electronic Engineering 

 

Lab Session 12  
 

 
PRACTICAL ON PLOTTING, FIXING AND DEVELOPING A FILM FOR 
EXPOSING OF PCB’S.  
 
OBJECTIVES 
 
Upon the completion of this experiment we will be able to  
1. Plot the film using photo plotter unit for exposing of PCB.  
2. The fixing and development of the film.  
 
BACKGROUND:  
 
For plotting of film a photo plotter unit is used. It exposes the film using a diode laser. 
The unit has an external power supply and is connected to PC via parallel port.  
For photo plotting a dark room must be arranged, with a special green safe light 
illumination for standard development and fixing process. Therefore a unit must be 
installed for development and fixation of the film, consisting of three tanks one each for 
development, fixation and rinse.  
The extent of delivery of photo plotter comprises of three software programs. The 1

st
, 

Gerb2Bitmap, serves for data preparation. This software exports the data in a proprietary 
FPF format for use on the plotter driver software. Further use of this software is i.e. o 
mount several layouts on one sheet of film, creation of step and repeat artwork. The 
second. Run Plotter, takes the so prepared data to control the plotter via the parallel port 
of your PC. It reads bitmap data in the above mentioned FPF format or at user’s choice in 
windows BMP or EAGLE TIFF format. In Run Plotter, you may select the output 
resolution as well as positive or negative, direct or mirrored output.  
The third application supplied is View Mate, a Gerber viewer and aperture converter tool. 
A built-in aperture converter helps transform the aperture tables of all CAD and CAM 
software into a standard format suitable for use with Gerb2Bitmap. 
 
OBSERVATION:  
 
Plotting:  

Material  Size( sq. mm) Plot Area (sq. mm) 
 
Fixing and development:  
 

Chemical Concentration 
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SUMMARY:  
 
Enter the dark room mount the film in line with white arrow on the drum of the photo 
plotter, with some tape. The emulsion side must be facing the drum and sheet edges must 
be parallel to drum axis. Close the lid and leave the dark room.  
Start the “Run_ Plotter” software, set image quality and size, and run the photo plotter 
software. The drum starts rotating and the plotting starts. The computer shows the 
estimated time countdown i.e. how much time is left in completion of plotting. After 
plotting is complete, enter the dark room, open the lid and remove the film from the drum 
and start the development of the film.  
The next part is the development and fixing of the film. Place the film removed from the 
photo plotter in the tank containing fixer. The film in then rinsed for 10 sec in tank 
containing water and after rinsing the film is dried. The film is then placed in developer 
solution for 30 seconds. After it rinse again and expose it to sunlight for few seconds.  
 
TESTS AND MEASUREMENTS:  
 

 • Light Source (Laser Diode):____________; λ =____________  
 

 • Resolution X:__________________.  
 

 • Resolution Y:__________________.  
 

 • Light Source (Dark room):___________________.  
 

 • Speed of Plotting (per second):________________.  
 
PRELIMINARY INSTRUCTIONS:  
 

 1. The film must not be exposed to normal light before its development and 
fixing, because the film consist of crystals of silver halides, which when exposed 
to light form an image, and as normal light falls on the screen all the crystals are 
exposed to light and the film gets black.  

 2. The film must not be twisted or bent and must be parallel to drum axis 
otherwise the image will be distorted.  

 3. The parallel port connecting PC to photo plotter unit must not be loose.  
 4. Film from different manufacturers show different light intensity. Therefore it is 

necessary to adapt that light intensity.  
 5. Keep the drum surface clean. Do not use spray cleaners for removing residues 

of tape.  
 6. During plotting process the film is exposed to the laser light. The light can 

injure the human eye. Never open the plotter lid during operation.  
 7. The emulsion side must be facing the drum.  

 
PROCEDURE:  
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 a) Plotting:  
 
Enter the dark room turn the green safe light ON and make sure there is no extra light 
from outside dropping in take a sheet pf film from its box and mount it in line with white 
arrow on the drum of the plotter, with some tape, which itself is in line with white arrow 
on the left of the drum housing.  
The emulsion side as mentioned earlier must be facing the drum, under green light, the 
emulsion side of the film normally looks grey, and the opposite side is darker. After 
fixing upper edges turn the drum by hand and sweep over the sheet so it goes tightly on 
the drum, and is parallel to it and that the upper and the lower sheet corners are facing 
each other.  
Close the lid and leave the dark room. Start the “Run Plotter” software, set image quality 
and size, (the output X resolution that can be set is 1016, 1355, 2032 and 4064, the Y 
resolution is fixed on 3000dpi) and run the photo plotter software. The drum starts 
rotating and after reaching normal speed the computer starts plotting with red diode laser. 
The red LED blinks according to the ON/OFF condition of the laser head. The compute 
shows the estimated time countdown i.e. how much time is left in completion of plotting.  
After plotting is complete, enter the dark room, open the lid and remove the film from the 
drum and start the development of the film.  
 

 b) Film Development and fixing:  
 
The next part is the development and fixing of the film. Place the film removed from the 
photo plotter in the tank containing fixer.(with a concentration of 1 part of fixer chemical 
and 2 parts of water) for 30 sec. The film in then rinsed for 10 sec in tank containing 
water. This step is taking because the developer will be destroyed if fixer drops in it. 
 
After rinsing the film dry it, place it on the smooth surface, wipe the 1

st 
side with a 

smooth fresh tissue and similarly the 2
nd 

side. The film is then placed in developer 
solution (with concentration 1 part of developer and 3 part of water) for 30 sec. After it, 
rinse again and expose it to sunlight for few seconds.  
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